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 What is Microsoft Office? 
  Microsoft  Office 2007 is a Windows application that consists of several 
applications, each designed to perform specific tasks:

   Outlook 2007 is an e-mail client with tools for organizing and 
searching e-mail.

   Word 2007 is a word processor application used to produce 
professional-looking documents such as letters, résumés, and 
reports.

   Excel 2007 is a spreadsheet application used to organize, 
analyze, and chart data.

   Access 2007 is a database application used to generate forms, 
queries, and reports from the data it stores.

   PowerPoint 2007 is a presentation application used to organize 
and format slides.

   Publisher 2007 is a desktop publishing application used to 
create publications such as newsletters and business reports.

 Microsoft Office is designed to create a productive and efficient work 
environment. Each application has a similar look and feel making it pos-
sible to transfer skills learned in one application to another. Data can be 
easily duplicated between the applications, reducing the time required to 
produce a document. For example, spreadsheet data can be easily added to 
a word processor document without having to retype the information.

Key Concepts
Understanding the Office interface
Using input devices
Saving, opening, and printing files
Searching the Web and citing sources
Understanding e-mail etiquette and ethics
Sending and receiving e-mail
Detecting and preventing malicious code
Exploring Office with the Help window
Creating secure passwords (Exercise 3)

Practice Data Files
HOMEWORK

Exercise Data Files
E-COMMERCE

TIP When purchasing 
software, a Windows 
application usually has the 
notation “for Windows” after 
the software name.

Operating System
All computers run software 
called an  operating system 
(OS). The OS allows the com-
puter to run other software and 
perform basic tasks, such as 
communicate with the user 
and keep track of files and fold-
ers. Types of operating systems 
include  Windows,  Linux, and 
 Mac OS. For more informa-
tion about a specific OS, visit 
www.Lpdatafiles.com.

Chapter 1
Microsoft Office Basics
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 The Microsoft Office Interface 
  Running an Office application displays an area on the screen called 
a  window where the user interacts with the software. The window is the 
application  interface.

 The Outlook and Publisher interfaces include a menu bar and toolbar. 
Word, Excel, Access, and PowerPoint have an interface that includes an 
Office Button, Quick Access Toolbar, and the Ribbon. Other features are 
common to both interface types:

• The file name of the open document is displayed in the  title bar. 
In Microsoft Word, Document1 is displayed in the title bar until 
the document is saved with a descriptive name.

• Click the  Office Button  to display a menu of commands for 
opening, saving, and printing a document.

• Click a button on the  toolbar or  Quick Access  Toolbar to execute 
a command.

• Click a tab on the  Ribbon or a word in the  menu bar to access 
groups of commands.

• Click  Minimize  to hide a window. A minimized, or hidden, 
window has a button on the  taskbar which can be clicked to dis-
play the window again.

• Click  Maximize  to expand the window to fill the screen.

Vista
 Windows  Vista is the new-
est operating system (OS) 
from Microsoft. It features a 
Windows Aero interface and 
includes built-in applications 
such as Internet Explorer 
7,  Windows Fax and Scan, 
 Windows SuperFetch, and 
 Windows Photo Gallery. 
Office 2007 is written to take 
advantage of Vista, but also 
runs under the older Windows 
XP OS.

window



 
 
 
 

SAMPLE 

Chapter 1 Microsoft Offi ce Basics 3

• Click  Restore Down  to restore the window to its smaller size. 
Restore Down  replaces Maximize  when a window has been 
maximized.

• The  insertion point is the blinking vertical line that indicates 
where the next character typed will be placed.

• View information about the document in the  status bar.

• Drag the  window corner to size the window.

• Drag the  scroll bar to bring unseen parts of the document into 
view.

• Click  Close  to close the window.

• Click  Help  to display a window with Microsoft Office help.

 Using Input Devices 
  Input devices are used to communicate with a Windows application. The 
most common input devices are the keyboard, mouse,  CD/DVD drive, 
 USB drive, and  disk drive. The keyboard is used to enter text and numeric 
data. A standard  keyboard has a layout similar to:

Press a key to enter that character at the insertion point. Press and hold 
the  Shift key while pressing a character key to enter uppercase letters or 
the character shown above a number or symbol on a key. The  Enter key 
is used to end a paragraph or terminate a line of text.

 Other keys and key combinations are used to move the insertion point 
or modify existing text. Depending on the situation, one method may be 
more  efficient than another:

• Press an  arrow key to move the insertion point within existing 
text without erasing or entering text. Press and hold an arrow key 
to keep moving the insertion point in that direction.  Ctrl+arrow 
key moves the insertion point from word to word in a document.

• Press the  Home key or  End key to move the insertion point to the 
beginning or end of a line of text, respectively. Ctrl+Home moves 
the insertion point to the beginning of the document, Ctrl+End to 
the end.

• Press the  Delete key to erase the character to the right of the inser-
tion point. Characters to the right move over to fill the gap.

• Press the  Backspace key to erase the character to the left of the 
insertion point. Characters to the right move over to fill the gap.

Keyboard Layout
The  QWERTY keyboard lay-
out was originally designed to 
prevent the keys from jamming 
on mechanical typewriter key-
boards. The name comes from 
the top row of alphabet keys.

TIP The  numeric keypad, 
located on the right of most 
keyboards, can make entering 
 numeric data more efficient. 
It also allows easy access to 
the mathematical operators 
+, –, *, and /. Num Lock must 
be on before numbers can be 
entered. Press the Num Lock 
key to toggle between on and 
off.
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• Press the  Esc (Escape) key to cancel the current operation. The 
specific effect of the Esc key depends on the current operation.

• Press the  Page Up or  Page Down key to move, or scroll, a document 
in the window. 

 The  mouse is an input device that is used to select commands and 
respond to application prompts. When using a mouse, a  mouse pointer is 
displayed on the screen. The pointer usually looks like , but will change 
depending on the situation. To point to an object, slide the mouse until 
the pointer is positioned on the object.  Click the object by pressing the 
left mouse button and releasing it quickly. Clicking an object selects it. 
Clicking a specific location in a document moves the insertion point to 
that position.

 The mouse can be used to perform other actions.  Double-click means to 
press the left mouse button twice in rapid succession.  Right-click means to 
press and release the right mouse button quickly. These actions have dif-
ferent effects depending on the object the mouse is pointing to. A mouse 
may contain a  wheel, which can be rotated to scroll through a document. 

 Most  handheld computers use a  stylus pen to perform the same func-
tions as a mouse.  Notebook computers may be equipped with a  touchpad, 
 trackball, or  pointing stick instead of a separate mouse.

 Practice: Working with a Document – part 1 of 3

!! START THE WORD 2007 APPLICATION
a. Ask your instructor for the appropriate steps to start Microsoft Office Word 2007.

b. Look at the Word window. Locate the features of the window, such as the Office 
Button , Ribbon, Quick Access Toolbar, and the insertion point.

@@ USE THE MOUSE TO MANIPULATE THE WINDOW
a. Slide the mouse. Note how the mouse pointer moves on the screen.

b. If the window is maximized, use the mouse to click Restore Down  to decrease 
the size of the window, otherwise click Maximize .

c. Click Minimize  to hide the Word window.

d. On the taskbar, click  to again display the Word window. Maximize 
the window if it is not already.

## TYPE TEXT
a. Type the following without pressing the Enter key: The Office 2007 applications 

are considered business productivity tools because they help users get organized, 
efficiently manage data, and easily create documents and publications.

b. Press the Home key. The insertion point moves to the start of the line.

c. Press the End key. The insertion point moves to the end of the line.

d. Press the Enter key to end the paragraph. Type your first and last name.

e. Press the appropriate key combinations to move the insertion point to the left of 
the “O” in “Office.” Which method did you use?

f. Press the Delete key the appropriate number of times to delete the words “Office 
2007” and the space that follows 2007.

 

 Optical Mouse
An optical mouse uses a red 
light-emitting diode ( LED) to 
detect mouse movement.

 pointing devices

mouse

scroll
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 Menus, Toolbars, and Commands 
 The Microsoft Office applications have an interface that includes either 
an  Office Button  and a  Quick Access  Toolbar or a menu bar and a tool-
bar. The Office Button  and menu bar work similarly. Click  to display 
a  menu of commands for working with a file. Some of the commands 
display an arrow. Point to the arrow to display additional commands:

 On a menu bar, click a word to display a menu of commands. Some of 
these commands also have arrows. Point to the arrow to display additional 
commands:

 Click a command to execute it or press the command’s  access key, which 
is indicated by the underlined letter in the menu. For example, press P to 
execute Print or S to execute Spelling.

 Menus can also be displayed by pressing the  Alt key and an access key. 
Press Alt+F to display the  menu. On a menu bar, each word contains 
an underlined letter that indicates its access key. For example, press Alt+T 
to display the Tools menu.

The j Symbol
In this text, the  j symbol 
indicates that a command 
should be executed. For 
example, “Select   j Open” 
means to click the Office 
Button and then select the 
Open command. As another 
example, “Select File j Open” 
means to click File on the 
menu bar and then select the 
Open command.

access key

displaying menus

menu
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 If a  command appears dimmed in a menu, then it is unavailable. To 
remove a menu from the screen, click outside the displayed menu or press 
the Esc key.

 A  keyboard  shortcut is a sequence of keys pressed to execute a command 
without first displaying a menu. By memorizing keyboard shortcuts, fre-
quently used commands can be executed without using the mouse. As a 
reminder of a keyboard shortcut, a ScreenTip is displayed when pointing 
to a command in the  menu:

In this case, Ctrl+P is the Print keyboard shortcut.

 In a menu bar menu, keyboard shortcuts are displayed to the right of 
the command name. For example, F7 is the Spelling keyboard shortcut.

 The toolbar and Quick Access Toolbar contain buttons for executing 
commands such as Save. Click a button to execute a command. Point to a 
button to display a  ScreenTip with the command name:

 
A button that appears  dimmed is unavailable.

 Using the Ribbon 
 The  Ribbon is an interface element that groups related commands into 
tabs. Each tab displays buttons, boxes, and other options for executing 
commands. For example, the Home tab on the Word Ribbon displays a set 
of  commands for editing text:

 Some buttons display text to indicate their purpose. If a button displays 
only a graphic, point to the button to display a ScreenTip with its name. 
To execute a command, click a button. For commands such as Font, a box 
is provided for entering the font name or selecting one from a list. Buttons 
with an arrow have additional options to choose from. For example, click 
Home j Font Color  to apply the default color or click  in Home j Font 
Color  to select a different color.

 Within a  tab, buttons are grouped. For example, the Home tab contains 
the Clipboard, Font, Paragraph, Styles, and Editing  groups. Tab groups often 
include a  Dialog Box Launcher. Click the Dialog Box Launcher  to display 
a dialog box of options related to that group.

TIP  Function keys, such as 
F7, are in the top row of a 
keyboard.

keyboard shortcut

The j Symbol
In this text, a second  j symbol 
indicates that a button option 
should be selected. For exam-
ple, “Click Home j Paste  j 
Paste Special” means to click 

 (the part of the button with 
an arrow) in Home j Paste and 
then select Paste Special.

TIP Press Alt once to display 
access keys for the Quick 
Access Toolbar and Ribbon.

TIP Keyboard shortcuts can 
increase  productivity because 
hands remain on the keyboard  
when executing a command.
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 The Ribbon changes depending on the activity. For example, inserting 
a graphic adds a Format tab to the Ribbon:

The Format tab is an example of a  contextual tab. It remains on the Ribbon 
for as long as those commands may be needed. In this example, the con-
textual tab remains for as long as the graphic is selected.

 If more space is needed for viewing a document, double-click a tab name 
to minimize the  Ribbon. The minimized Ribbon displays only tabs:

To restore the Ribbon, double-click a tab name.

 Dialog Boxes 
 Commands often require additional input from the user before an 
action can be completed. A  dialog box is a small window with options for 
completing an action. For example, select  j Print to display the Print 
dialog box:

• Click the  drop-down arrow to display a list of options.

• Select an  option button to indicate a choice from a set of options.

• Click  check boxes to select or clear options.

• Type information in a  text box.

TIP Press the  Tab key to 
move from option to option 
in a dialog box to increase 
 productivity. Once an option 
is selected, press an arrow key 
or the spacebar to change the 
value for a selected option.

TIP An  ellipsis  (…) after a 
command name in a menu or 
a name on a command button 
indicates that a dialog box will 
appear.

minimizing the Ribbon

contextual tab

Alternative Press  Alt and an 
access key to select an option.
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• Select a  command button to initiate an action. Command buttons 
are often referred to as just button. For example, the OK button is 
to the left of the Cancel button.

• Click  Help  to display a window with information about using 
the dialog box.

• Click  Close  to remove a dialog box without applying any 
options. Select Close, Cancel, or press the Esc key to perform the 
same function.

 The  default  button is the button displayed with a thicker border when 
the dialog box is first displayed. The default button can be selected by 
pressing the Enter key. In the Print dialog box, OK is the default button.

 Saving Files 
 Once a document has been created in an application, it should be saved 
as a file. A  file is a collection of related data stored on a lasting medium, 
such as a hard disk. A saved file can be loaded into memory for further 
editing at a later time. The modified document must then be saved again 
to  overwrite the original file with the changed file. A good  work habit is 
to save a document often as it is being modified to prevent accidental loss 
from a power interruption or network problem.

 A file must be given a name to identify it. A  file name is a unique name 
for a file stored on disk. When a new document is created, the title bar 
displays a general description, such as Document1 or Book1, until the 
document is saved. Select  j  Save or click  Save  on the Quick Access 
Toolbar to save a document. The  Save As dialog box is displayed the first 
time a file is saved:

Storage Media
Files can be stored for later 
retrieval on various types of 
 storage media, such as  mag-
netic ( hard disk),  optical ( CD, 
 DVD) or  semiconductor (USB 
 Flash drive).

Default Settings
A  default setting is the setting 
that is automatically selected 
unless it is changed by the 
user.
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Files are organized into folders. A folder is indicated by , which looks 
similar to a manila folder used to store printed documents in a file cabi-
net. The Save As dialog box has features for navigating to the appropriate 
folder for storing the file:

• The  Address bar displays the location where the file will be saved. 
To navigate to a different location, click an arrow in any part of the 
Address bar and then click a drive or folder location. For example, 
in the Save As dialog box, click  next to Public Documents to display 
folders in that location:

• The  Navigation pane displays folders and locations. Click a folder 
or location in the Navigation pane to display those contents.

• The  File list displays the contents of the current  folder. Double-
click a folder in the File list to display its contents.

• The File name box should be changed to a name that is valid and 
descriptive of the file’s contents. A valid  file name can contain let-
ters, numbers, spaces, and the underscore character (_), but cannot 
contain colons (:), asterisks (*), question marks (?), and some other 
special characters. Examples of valid, descriptive file names are 
Biology Paper, GADGETS LOGO, and Memo 2009 02 09.

 Applications automatically add an extension to the file name when 
saved. An  extension indicates the file type and is used by the application 
to recognize files. Word 2007 automatically adds the  .docx extension to 
file names.

 Printing a Document 
 To  print a document, select  j  Print, which displays the Print dialog 
box. In the Print dialog box, select OK to print one copy of the document. To 
print more than one copy of the document, type a number in the Number 
of copies box and then select OK. To print specific pages, select Pages, type 
the appropriate page number or range of pages in the Pages box, and then 
select OK.

TIP Always save before  
printing.

 Microsoft Office Open 
XML Format

The Microsoft Office Open 
 XML format automatically 
compresses  files to save on 
disk space, structures  files in 
a way that limits damage from 
 corruption, and addresses  pri-
vacy concerns by giving users 
more control over the per-
sonal information included in 
a document. Office file name 
extensions ending with x or m 
use the Microsoft Office Open 
XML format.

TIP Click  in the 
Save As dialog box and then 
type a descriptive name to 
create a new folder in the 
current location.

TIP The Address bar displays 
a  hierarchy, or path, to the 
last folder name listed.
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 Practice: Working with a Document – part 2 of 3 
Word should be already started with text typed into a new document.

!! SAVE THE DOCUMENT
a. On the Quick Access Toolbar, click Save . The Save As dialog box is displayed.

b. Use the Address bar and the File list below it to navigate to the appropriate loca-
tion for the file to be saved. You may have to ask your instructor for instructions 
on navigating to the appropriate folder.

c. The file name in the File name box needs to be replaced with a descriptive file name. 
In the File name box, type: Application Practice

d. Select Save. The file is saved in the selected location with the name Application 
Practice and the file name is displayed in the title bar of the document window.

@@ PRINT THE DOCUMENT
a. Select  j Print. The Print dialog box is displayed. The appearance and options 

available in the Print dialog box will vary depending on the printer or printers 
connected to your workstation or network.

b. Set the Number of copies to 1, if it is not already.

c. Select OK. The document is printed.

 

 Closing a Document 
 When finished working on a  document, it should be saved and then 
closed.  Closing a document means that it is removed from the application 
window and the file is no longer in the computer’s memory. Select  j 
 Close to close a document. A warning dialog box is displayed if the docu-
ment has been modified since it was last saved.

 Quitting an Application 
  Quitting an application means that the  application window is removed 
from the  desktop and the program is no longer in the computer’s memory. 
To quit an Office application, select the exit command. For example, to exit 
Word, select  j  Exit Word.  Close  in the upper-right corner of the 
application window can also be used to quit the application.

 Opening a File 
  Opening a file transfers a copy of the file contents to the computer’s 
memory and then displays it in an application window. To open a  file, 
select  j Open, which displays the Open dialog box:

The Desktop
When the Windows operating 
system is running, the com-
puter screen is referred to as 
the desktop.

Recent Documents List
The  menu displays a Recent 
Documents list when files have 
been previously opened. Click 
a file name in the list to open 
that file.
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Use the Address bar and File list to navigate to the appropriate file. Click 
the file name and then select Open to display the file.

 Use column headings to organize the File list to make finding a specific 
file faster. Point to a heading and then click  to display options:

Click Sort to sort the names alphabetically, or click a check box to limit 
the displayed files.

 Practice: Working with a Document – part 3 of 3 
Word should already be started with Application Practice displayed from the last practice.

!! CLOSE APPLICATION PRACTICE
 Select  j Close. The document is removed from the Word window.

@@ OPEN A DOCUMENT
a. Select  j Open. The Open dialog box is displayed.

b. Navigate to the location of Application Practice. You may have to ask your instructor 
for instructions on navigating to the appropriate folder.

c. In the File list, click Application Practice and select Open. The Application Practice 
document is again displayed in a window.

## QUIT WORD
 Select  j Exit Word. The Word window is closed.
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 Searching the Web 
 When researching information for a document, one widely used resource 
is the World Wide Web. The Web is used to search and access information 
on the Internet and requires a  Web browser application, such as Microsoft 
Internet Explorer to view the Web site pages.

 A  search engine is used to locate information on the Web. Search engines 
search a database of Web pages for specified words or phrases and then 
list the hyperlinks to the pages containing the text. Search engine Web 
sites include:

 Google (www.google.com) Excite (www.excite.com)
Yahoo! (www.yahoo.com) Go (www.go.com)
Ask (www.ask.com) Lycos (www.lycos.com)
MSN (www.msn.com)

 The words or phrases used in a search are called the  search criteria. 
Search criteria should be carefully specified using  keywords related to 
the topic of interest. For example, if searching for information about Bryce 
Canyon, the  criteria bryce returns numerous Web sites, many of which 
have nothing to do with the Bryce Canyon. A more successful search uses 
the criteria bryce canyon to limit the number of Web sites.

 There are several ways to specify search criteria. Surrounding phrases 
with quotation marks finds Web pages that contain the entire phrase 
exactly. The  + (plus sign) can be used to find pages that contain specified 
words. For example, hawaii +museum matches pages that contain the 
words Hawaii and museum. Separating words with a space has the same 
effect as the plus sign. The  – (minus sign) can be used to exclude unwanted 
Web pages. For example, hawaii –museum matches pages that contain the 
word Hawaii but not the word museum.

 The +, –, and space can be combined to produce more precise search 
criteria. For example:

horse + buggy –carriage
tuna salmon –salad
recipe chicken –soup
university + connecticut –yale

 The  logical operators  AND,  OR, and  NOT are sometimes used to specify 
search criteria. The operator AND has the same effect as the + and space. 
The operator OR is used to find Web pages that contain one word or 
another or both. For example, f lorida OR hotel returns links to pages con-
taining Florida, hotel, and Florida and hotel. The operator NOT has the 
same effect as – (minus sign).

 When operators are used in search criteria, a  Boolean expression is 
formed. A Boolean expression evaluates to either true or false. For example, 
the criteria hawaii +museum evaluates to true when a Web page contains 
Hawaii and that same Web page contains museum. When an expression 
evaluates to true, a link to the Web page is displayed.

Search Engines
A search engine usually works 
by sending out an agent, such 
as a  spider. A spider is an 
application that gathers a list 
of available Web page docu-
ments and stores this list in 
a database that users can 
search.

The Internet
The largest and most widely 
accessed network is  the 
 Internet, a worldwide net-
work of computers that is not 
controlled by any one organi-
zation. The Internet has had an 
undeniable impact on modern 
society because it allows users 
worldwide to communicate 
and access information in a 
matter of seconds.

Site Categories
Some search engines provide a 
 Web directory, or  subject tree, 
which is a list of sites separated 
into categories.

TIP For more information 
about the Web and Internet 
Explorer, visit 
www.Lpdatafiles.com.

TIP The Vista OS includes 
Internet Explorer 7. Other 
Vista-compatible  browsers 
include Firefox, Opera, and 
AOL.



 
 
 
 

SAMPLE 

Chapter 1 Microsoft Offi ce Basics 13

 Practice: Searching the Web
You will need a Web browser and Internet access to complete this practice.

!! GO TO THE GOOGLE SEARCH ENGINE
a. Start Internet Explorer.

b. In the Address box, replace the existing URL with www.google.com:

c. Press Enter. The Google home page is displayed.

@@ TYPE SEARCH CRITERIA
a. In the search box, type: shakespeare

b. Click Google Search to start the search. After a few moments a list of Web site 
hyperlinks are displayed. How many pages match the criteria?

c. Scroll down to display the results of the search, then click one of the hyperlinks 
that interests you. A new page is opened. 

## SELECT OTHER WEB PAGES LOCATED IN THE SEARCH
a. On the toolbar, click Back . The Web site hyperlinks are again displayed. Click 

a different hyperlink.

b. Continue this process to access additional pages.

$$ DEFINE CRITERIA USING LOGICAL OPERATORS
a. Refine the search criteria to: shakespeare OR "Globe Theatre" and see how many 

Web page matches there are.

b. Refine the search criteria to: shakespeare +"Globe Theatre" and see how many 
Web page matches there are.

c. Further refine the criteria to: shakespeare +"Globe Theatre" +reconstruction –usa 
and see how many Web page matches there are.

d. Click a few of the hyperlinks to determine if the Web pages include the information 
that is being searched for.

%% GO TO THE YAHOO SEARCH ENGINE
a. In the Address box, replace the existing URL with www.yahoo.com, the URL for 

Yahoo’s home page, and then press Enter. The Yahoo home page is displayed.

b. In the Search box, type stonehenge and then click Web Search. After a few moments 
a list of Web site hyperlinks are displayed. Note the number of Web page matches 
there are.

c. Use the Google search engine (www.google.com) to find Web pages matching 
stonehenge. How many pages match the criteria? How does the Yahoo! search 
compare to the Google search?

^̂ CLOSE THE BROWSER
 Click Close  to close the browser window.
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 Citing Web Sources 
 If information from a   Web site is to be referenced or quoted in a report, 
essay, or other document, a  citation must be used to give credit to the 
original author and allow the reader to locate the cited information. A 
widely accepted form for citation is published by the  Modern Language 
Association (MLA) in its publication  MLA Handbook for Writers of Research 
Papers, Sixth Edition.

 In general, a citation for material located at a Web site should look 
similar to: 

Author’s Last Name, First Name MI. "Document Title." Site 
Title and last-updated date. Access date. 
Organization name. <URL>.

 A citation of a personal Web site does not have many details:

Rawlings, Julie. Home page. 23 Dec. 2007. 15 May 2009. 
<http://www.Lpdatafiles.com/julie/index.htm>.

 A citation of an article in an online magazine should include a volume 
number or issue number:

Schiffman, Paula. "Making Vinegar at Home." Vinegar 
Monthly Vol. 1 May 2007. 30 Oct. 2009. <http://
www.Lpdatafiles.com/vinegarassoc/journal.asp>.

 A citation of a posting to a discussion group includes the discussion 
group name:

Cruz, Anthony. "Are Orchestras Going Downhill?" Online 
posting. 10 June 2008. Oboe Discussion Group. 23 
Nov. 2009. <http://www.Lpdatafiles.com/odg/
downhill.txt>.

 Multitasking 
  Multitasking is an operating system feature that allows more than one 
application to run at a time. When using multitasking effectively, tasks 
are completed more  efficiently. For example, a report that requires a chart 
and some research could be completed by having Word, Excel, and a Web 
browser running at the same time and then switching between them to 
organize the information into the Word document.

 The Windows  taskbar displays buttons for each open file or applica-
tion. Point to a button to display a  thumbnail, or miniature version, of the 
document:

Click a button to display the application.

TIP Web sites change 
frequently or may disappear 
altogether. Therefore, it is 
a good work habit to keep 
printouts of a Web source for 
later reference.

TIP Click the taskbar button 
of a displayed application to 
hide the application window.

Avoiding  Plagiarism
All sources of information that 
are used to support research 
must be cited. This includes 
e-mail messages, graphics, 
sounds, video clips, and news-
groups postings.

TIP Citing sources is also 
discussed in Chapter 4.
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 Practice: Sample Citation
You will need a Web browser and Internet access to complete this practice.

!! START WORD
a. Start Word. A new, blank document should be displayed.

b. Type An example citation: and press Enter.

@@ START THE BROWSER
a. Start Internet Explorer. Note that there are two buttons on the taskbar. One button 

for the Word document and one for the browser.

b. In the Address box of the browser, type www.Lpdatafiles.com/surfing and then 
press Enter. The Surfing Web site is displayed.

c. Review the information on the Web page. Locate the author’s name, the title, and 
the last updated information.

## CREATE A CITATION
a. On the taskbar, click the button for the Word document. The Word window is again 

displayed. Note that the insertion point is in the same position as it was left.

b. Use the buttons on the taskbar to switch between Word and the browser to deter-
mine information needed for the citation. In Word, type a citation for the Web site 
without pressing the Enter key. To underline the Web site name, select the text and 
then click Home j Underline :

Wu, Ana. "Surfing the Web." Surfing. 12 May 2009. 5 Jun 2009. <http://www.
Lpdatafiles.com/surfing>

c. Save the document naming it Sample Citation and then print a copy.

$$ QUIT THE APPLICATIONS
a. Close Sample Citation and then quit Word. The Word window is closed and the 

browser window is again displayed.

b. Close the browser window.

 

 What is E-Mail? 
 Once complete, a document can be e-mailed to the recipient. E-mail 
means electronic mail and is the sending and receiving of messages and 
files over a  communications network such as a  LAN ( Local Area Network) 
or the  Internet. E-mailing a document has many advantages, which include 
allowing a far-away recipient to receive a document very quickly. With 
Microsoft Office, documents can be  e-mailed directly from within the 
application used to create the document or sent as an attachment.

Mailing List Server
A  mailing list server, such as 
 LISTSERV, manages Internet 
mailing lists. Special interest 
groups often use a mailing list 
for discussion purposes. When 
a subscriber posts, or e-mails, 
a message to the mailing list, 
every subscriber receives a 
copy. Mailing lists sometimes 
have a  moderator who filters 
the messages before posting.
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 An  e-mail address is required in order to send and receive e-mail 
messages. E-mail addresses are provided when you sign up with an  ISP 
(Internet Service Provider) or a Webmail service. A typical e-mail address 
is similar to:

 An  e-mail client is software that is used to read messages, create and 
send messages, list and organize messages, and manage e-mail addresses 
in an address book. Outlook, Eudora, Yahoo! Mail, and GMail are some 
popular e-mail clients.  Yahoo! Mail and  GMail run in a Web browser and 
are called  Web-based  e-mail clients or  Webmail accounts.

 When an e-mail client sends or receives a message, it connects to an 
e-mail  server, which is a computer running special software and connected 
to the Internet. The e-mail client typically connects to an  SMTP server 
(Simple Mail Transfer Protocol) for outgoing mail. For incoming mail, a 
connection to a  POP3 (Post Office Protocol3) or  IMAP (Internet Mail Access 
Protocol) server is made.

 Unfortunately, when using e-mail there is the risk of receiving malicious 
code, such as  viruses,  Trojan horses, and  worms. An e-mail client usually 
includes an  e-mail filtering system, but  antivirus software that runs in 
addition to the e-mail client is a necessity.

 E-Mail  Etiquette and  Ethics 
 When communicating through e-mail, professionalism and courtesy 
are expected.  E-mail etiquette for composing messages includes:

• Be concise.

• Use  manners. Include “please” and “thank you” and properly 
address people you do not know as Mr., Ms., Mrs., Dr., and so on.

• Use proper spelling, grammar, and capitalization. Do not use all 
capital letters to type a message. All capitals are the equivalent of 
SCREAMING.

In general, re-read a message before it is sent. Always fill in the To box last 
to avoid sending a message before it is complete.

 Using  e-mail also requires following a code of ethics:

• Send messages through your account only. Do not try to deceive 
recipients by falsely representing yourself.

• Keep the subject in the message header short and truly representative 
of the message. Recipients may judge the authenticity of the message 
based on the subject and decide to delete the message.  Antivirus 
software and e-mail filtering systems may send your message to 
the  Spam or  Junk E-mail folder if the subject is inappropriate.

• Use appropriate subject matter and language.

• Be considerate of other people’s beliefs and opinions.

• Respond to e-mail messages in a timely manner.

Top Level Domain
The  domain name includes the 
top level domain after the dot. 
The top level domain indicates 
the domain type. For example, 
 com indicates a commercial 
business and  edu indicates 
educational institution.

Spoofing
Spoofing is the  unethical and 
 illegal practice of providing a 
Subject that lures an individual 
into opening an e-mail about 
an entirely different topic. The 
 CAN-SPAM Act of 2003 pro-
vides penalities for commercial 
e-mailers who send deceptive 
messages.

e-mail server

malicious code

Web-based e-mail
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• Do not attempt to access e-mail from someone else’s account 
without permission.

• Do not give out someone else’s e-mail address without first 
obtaining permission.

 E-mail messages are not private. An e-mail message goes through 
several mail servers before it reaches the recipient, making it possible for 
others to intercept it. E-mail messages are also easily forwarded. When 
sending e-mail at work or school, it is important to remember that employ-
ers and school administrators have the right to read any e-mail messages 
sent over the  corporate or  school network, as well as the right to track 
online activity.

 Using Outlook 
 The Microsoft Outlook e-mail client is a  personal information manager 
with tools for managing e-mail messages. Outlook Today is displayed 
when Outlook is started. Click the Messages link or the Inbox folder to 
display the Mail window:

The  Mail window contains several panes:

• The  Navigation Pane lists folders where e-mail messages are 
stored.

• The next pane displays the e-mail messages stored in the selected 
folder, in this case the Inbox. This pane also contains the  Instant 
Search pane for searching messages.

 Encryption
One way to protect the pri-
vacy of an e-mail message 
is to encrypt the message, 
which converts the message 
to scrambled or cipher text. 
The recipient of the message 
needs a key to unscramble the 
message.
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• The  Reading Pane displays the selected message. The selected 
message is displayed with a  message header, which contains the 
subject of the message, the recipients, and the sender.

• The  To-Do Bar lists appointments.

 To create a new e-mail message, click  on the toolbar or select 
File j New j  Mail Message. A window for composing an e-mail message is 
displayed. The window has the Ribbon interface, similar to Word:

• In the Subject box, type a  title that describes the message.

• In the large empty space, compose the  message.

• In the  To box, type the e-mail address of the recipient . If an e-mail 
message is to be sent to more than one individual, separate e-mail 
addresses with a semi-colon (;).

• In the  Cc box, type the e-mail addresses of any recipients that are 
to receive a “carbon copy” of the e-mail.

• Click Send to send the message.

 To retrieve messages from the e-mail server, click Send/Receive. New 
 messages are placed in the Inbox folder and message headers are displayed 
in the second pane. One way to help prevent malicious code from infect-
ing a computer is to turn off the Reading Pane until new messages are 
scanned for suspicious addresses and attachments. Turn off the Reading 
Pane by selecting View j Reading Pane j  Off.

 To reply to a selected message, click Reply on the toolbar. A new message 
window containing the selected message is displayed. A new message, 
or reply, can be typed above the original message. Click Send to send the 
reply. By including the original message, the recipient will have a reference 
when reading the reply.

 To print a message, click Print  on the toolbar. A message is move to 
the Deleted Items folder when Delete  on the toolbar is clicked.

TIP A copy (Cc) of an e-mail 
is often sent to group leaders, 
supervisors, or others who 
may need to be kept informed 
of a situation, but not actually 
interact with the e-mail 
recipients in the To box.

Mail Formats
The format of outgoing e-mail 
messages can be set to    HTML, 
 plain text, or  rich text.

HTML is the default and rec-
ommended format because it 
is used by most e-mail clients. 
Plain text format is understood 
by most e-mail clients, but it 
does not support formatting, 
such as bold. Rich text format 
supports numerous formatting 
options, but is only understood 
by certain e-mail clients. 

Select Tools j Options and 
then select the Mail Format tab 
to change the mail format.

TIP Outlook checks  spelling 
as a message is typed. Right-
click a wavy red line under a 
word to see spelling options.

printing and deleting 
messages
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 Practice: E-Mail Messages – part 1 of 3
You will need Internet access to complete this practice.

!! START OUTLOOK AND DISPLAY THE MAIL WINDOW
a. Ask your instructor for the appropriate steps to start Outlook.

b. Click the Messages link. The Mail window is displayed.

@@ CREATE AN E-MAIL MESSAGE
a. On the toolbar, click New. In the displayed window, type a subject and message, 

replacing Classmate with a classmate’s name and Name with your name:

b. Exchange e-mail addresses with a classmate. Type your classmate’s e-mail address 
in the To box. If your instructor is to receive a copy of the e-mail, then type your 
instructor’s e-mail address in the Cc box.

c. Click Send. The e-mail message is sent.

## RECEIVE AND PRINT AN E-MAIL MESSAGE
a. On the toolbar, click Send/Receive. Messages are retrieved from the e-mail server 

and placed in the Inbox.

b. In the Inbox pane, select the message from your classmate. The message is displayed 
in the Reading Pane.

c. On the toolbar, click Print . The e-mail message is printed.

$$ REPLY TO AN E-MAIL MESSAGE
a. On the toolbar, click Reply. A window is displayed with the original message and 

the sender’s e-mail address in the To box. Note that the prefix “RE:” has been added 
to the beginning of the subject line in the Subject box.

b. Type the following message, replacing Name with your name: Thank you for sending 
the homework assignment. I think I will research smartphones.   --Name

c. Click Send.
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 The Address Book 

 The  Address Book stores contact names and e-mail addresses. Click 
 Address Book  on the toolbar to view entries in the Address Book:

 To add a new contact, select File j New Entry.

  As an e-mail address is typed in the To or Cc box of a message window, 
a list of Address Book names appears. Use the arrow keys to select the 
appropriate address and then press Enter to insert the entry. An e-mail 
address can also be selected from the Address book by clicking  or 

.

 E-Mail Attachments 
 E-mail provides a way to quickly send a  file. In a new message window, 
click Insert j   Attach File to display the Insert File dialog box. Select a file 
and then select Insert. The name of the attached file is displayed in the 
Attachment box in the e-mail header.

 The recipient can choose to save an attachment in an appropriate location 
or open it directly from the e-mail. To save an attachment, select File j 
 Save Attachments and then select the attachment. A dialog box is displayed. 
Navigate to the location for the file and then select Save. Attachments can 
also be saved by right-clicking the attachment and selecting Save As from 
the displayed menu.

 To open an attachment, the recipient will need to have the appropriate 
application. For example, if a Word file is attached, then the recipient must 
have Word to open the file. A Word file in its native format is recognized 
by the . docx extension in the file name.  Native format is the format that an 
application normally uses for saving a file.

Attaching Multiple Files
When a  folder of files is to 
be attached to an e-mail, a 
 compression  utility, such as 
WinZip, is needed to main-
tain the folder structure. Using 
WinZip, the folder of files can 
be compressed into one  .zip 
file. The recipient must then 
use the same utility to extract 
the files. As an added advan-
tage,  WinZip reduces the file 
sizes during compression, mak-
ing the attachment smaller.

Distribution List
A distribution list consists of a 
group of related contacts, such 
as club members or classmates, 
and is used to send messages 
to a group of people.

To create a distribution list, 
select File j New j  Distribution 
List and then select members 
from the displayed Address 
Book.

TIP Contacts added to 
the Address Book are 
automatically added to the 
 Safe Senders list, which 
ensures e-mail messages 
from the contact will not be 
classified as  junk e-mail.
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 Sending files in their native format is necessary if the user is to edit 
the file, but inconvenient if the user simply needs to view the file. One 
solution is to attach a file that has been saved in  text format. Files in text 
format typically have the extension . txt or . rtf. Text files can be opened by 
any word processor. The disadvantage of the text format is that much of 
the document formatting may be lost or changed. A more commonly used 
solution is to  export a file to  PDF format before attaching it to an e-mail. 
The PDF file format is widely used because all document formatting is 
preserved.

 To view a PDF, recipients use  Adobe Reader, a free application from 
Adobe Systems that most users already have. To enable PDF export from 
Office, select  j Save As j  Find add-ins for other file formats and follow 
the directions in the Help window.  Add-ins are programs that extend the 
capabilities of an  Office application. 

 Practice: E-Mail Messages – part 2 of 3 
You will need Internet access to complete this practice. Outlook should already be started from the last 
practice.

!! ADD AN ENTRY TO THE ADDRESS BOOK
a. On the toolbar, click  Address Book . The Address Book is displayed. Note the 

addresses currently listed.

1. On the Address Book menu bar, select File j New Entry. Another dialog box 
is displayed:

2. In the Select the entry type box, select New Contact and then select OK. A Contact 
window is displayed.

3. Complete the Full Name box and E-mail box entries using the name and e-mail 
address of a classmate. Note that Outlook automatically creates an entry for 
the File as box.

4. Click Contact j Save and Close. The Contact window is removed and the 
contact appears in the Address Book.

5. Click Close  to remove the Address Book.

@@ CREATE AN E-MAIL MESSAGE AND ADD AN ATTACHMENT
a. On the toolbar, click New. A Message window is displayed.

add-ins

PDF
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b. In the message window, click To. The Select Names dialog box is displayed.

1. In the Name list, select the name of your classmate.

2. At the bottom of the dialog box, click To.

3. Click OK. The dialog box is removed and your classmate’s e-mail address 
appears in the To box of the message window.

c. In the Subject box, type: My Assignment

d. In the Message body, type the following, replacing Name with you name: Here 
is a copy of my homework assignment. Can you proofread it for me? Thank you. 
--Name

e. In the Message window, click Insert j Attach File. A dialog box is displayed.

1. Navigate to HOMEWORK, which is a data file for this text.

2. Select Insert. The file is attached to the message.

3. The file size of the attachment is displayed to the right of the file name. What 
is the file size of HOMEWORK?

f. In the message window, click Send.

 

 Organizing E-mail Messages 
 Related e-mail messages should be organized into folders. Outlook 
automatically creates some folders and rules that direct specific e-mail 
messages to the appropriate folders. These folders are displayed in the 
Navigation pane:

•   Inbox stores received messages.

•   Sent Items stores messages that have been sent.

•   Deleted Items stores messages that have been deleted until they are 
permanently deleted or retrieved. Messages stored in the Deleted 
Items folder are permanently deleted by right-clicking the Deleted 
Items folder and selecting Empty "Deleted Items" Folder from the 
displayed menu. Messages can be retrieved from this folder by 
dragging the appropriate message to another folder.

•   Drafts stores unfinished messages that have been automatically 
saved by Outlook because they have been open for a time.

•   Outbox stores messages that have been created and not yet sent.

•  Junk E-mail stores received messages that have a subject line or 
e-mail address which has been flagged by antivirus software or 
another e-mail  filtering system.

 The Inbox arranges  e-mail messages by date. This arrangement can be 
changed to display e-mail messages alphabetically by sender, by recipi-
ent, or by subject. Changing the arrangement may help locate a message. 
However, related e-mail messages in the Inbox should be organized into 
folders with descriptive names to make it easy to locate messages. Right-
click the folder name and then select New Folder to display the Create New 
Folder dialog box.

display options

Rules
 Rules help manage e-mail 
messages by automatically 
performing an action based 
on a condition. For example, 
move all messages from Susan 
Thompson to the Sales folder. 
To create a rule, select Tools j 
 Rules and Alerts.

creating a folder
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 The  Instant Search pane is used to  search messages. For example, to 
search for e-mail containing the text research project, type those keywords 
into the Instant Search pane:

As the keywords are typed, the current e-mail folder is searched and 
matching messages displayed with the keywords highlighted. To quit 
searching, click Clear Search  in the Instant Search pane.

 E-mail Security 
 E-mail is an effective way to communicate. Unfortunately, along with 
personal and business messages, most people also receive a lot of “  junk 
e-mail,” also called spam. Outlook has a  Junk E-mail Filter, which catches 
obvious junk mail and automatically places it the Junk E-mail folder. This 
folder should be checked periodically to ensure a legitimate message 
has not accidentally been filtered to this folder. If a legitimate message is 
located in this folder, right-click the message and select Junk E-mail j  Mark 
as Not Junk and then select OK to move the message to the Inbox.

 It is also possible to block messages from specific senders. Right-click a 
message from the sender to be blocked and select Junk E-mail j  Add Sender 
to Blocked Senders List. To view and edit the Blocked Senders list, select 
Tools j  Options, which displays the Options dialog box. Select Junk E-mail
and then select the Blocked Senders tab to display those options:

To remove a name from the  Blocked Senders list, select the name and then 
select  Remove. Blocked senders can also be added in this dialog box by 
selecting Add and typing the sender’s e-mail address.

spam

 IRM
 Information Rights Manage-
ment ( IRM) allows e-mail 
messages to be restricted so 
that recipients may not for-
ward, print, edit, or copy 
an e-mail message. Before 
sending a message, select 

 j  Permission for restric-
tion options. IRM requires 
installing the  Windows Rights 
Management Services (RMS) 
Client.

using Instant Search

TIP The  Safe Senders tab in 
the Junk E-mail Options dialog 
box is used to ensure that e-
mail from specified addresses 
will not be treated as junk 
e-mail.

TIP Click Show Instant Search 
Pane Menu  or click  to 
expand the Instant Search 
pane for additional search 
options.
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 Cybercrime includes the delivery of malicious code in an e-mail mes-
sage. Malicious code, such as  viruses,  Trojan horses, and worms may be 
delivered in an e-mail attachment or through  spam. A message carrying 
malicious code can have a familiar e-mail address because address books 
are often the target. Messages from unfamiliar individuals or companies 
require extra precautions. Just opening an infected  e-mail could execute 
malicious  code.

 Viruses have varying effects, such as displaying annoying messages, 
causing programs to run incorrectly, and erasing the contents of the hard 
drive. A Trojan horse appears like a useful computer program, but actually 
causes damage to data and can download stronger threats. A  worm is a 
malicious program that can replicate itself, use up a system’s memory, and 
bring a system down.

 A growing security threat is  phishing and  pharming (pronounced “fish-
ing” and “farming”) e-mails. Both involve  online fraud and are forms of 
cybercrime. This crime, also referred to as  identity theft, seeks to obtain 
confidential information in order to rob an unsuspecting individual of 
his or her identity. Personal information, such as identification numbers 
or credit card numbers, should never be included in an e-mail message. 
E-mail messages that prompt you to visit a Web site to verify personal 
information should be deleted without visiting any Web site links or 
replying to the e-mail.

 Outlook provides some protection from e-mail viruses and other mali-
cious code by automatically blocking attachment files that contain code 
that can run without warning, such as  .bat,  .exe,  .vbs, and  .j files. However, 
precautions still need to be taken to minimize the possibility of malicious 
code damaging important data:

• Invest in  antivirus software. Antivirus software will detect many 
types of viruses by scanning incoming e-mail messages before 
they are opened. If a virus is detected, the software will display a 
warning and try to remove the virus.

• Update the antivirus software frequently. New viruses are 
continually being created and new virus definitions must be 
downloaded on a regular basis in order for the antivirus software 
to be effective.

• Always save an attachment file and then  virus-check the file before 
opening it. This precaution should be taken for all messages from 
known and unknown sources, since many viruses target address 
books and fool users into thinking the e-mail is from someone 
familiar.

• Protect your  personal information and review  bank and  credit card 
statements regularly.

 Practice: E-mail Messages – part 3 of 3
Outlook should already be started from the last practice.

!! CHANGE ARRANGEMENT OF INBOX MESSAGES
a. Display the Mail window if it is not already showing.

Easier Virus Detection
The Microsoft Office Open 
 XML format uses file name 
extensions ending with m 
for documents that contain 
macros. Because  macros are 
code added to a file, the added 
m makes it easier for  virus 
proptection software to deter-
mine if a file could possibly 
contain malicious code.

phishing, pharming

identity theft

worm

viruses

Trojan horse
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b. At the top of the Inbox pane, click Arranged By. A menu is displayed:

c. In the menu, select From. Scroll to view all of the messages. Note that the e-mail 
messages are arranged in alphabetic order by the sender’s name.

d. Arrange the messages by Subject.

e. Arrange the messages by Date.

@@ CREATE A NEW FOLDER
a. Right-click the Inbox folder. A menu is displayed.

1. Select New Folder. A dialog box is displayed.

2. In the Name box, type Homework.

3. In the Select where to place the folder list, select Personal Folders:

4. Select OK. The new folder is created and displayed in the Navigation Pane.
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## SEARCH FOR A MESSAGE AND MOVE A MESSAGE TO A FOLDER
a. In the Instant Search pane, type Homework Assignment:

 Messages with the text Homework Assignment are displayed and the search text 
highlighted.

b. Drag the Homework Assignment message from the last practice to the Homework 
folder. The message is moved.

c. In the Navigation Pane, click Inbox to exit the Instant Search.

$$ QUIT OUTLOOK

 

 Using Microsoft Office Help 
 The Microsoft  Office Help window is displayed by clicking Help  or 
by pressing the  F1 key. Each Office application has its own specific Help 
window. For example, the  Word Help window looks similar to:

 The Help window functions much like a Web browser. There is a toolbar 
with navigation buttons that go  Back  or  Forward  through visited 
topics. Other navigation buttons are  Stop ,  Refresh , and  Home . 
 Print  is used to print the current contents of the Help window.

 The Word Help home window includes a  Browse Word Help section 
with links to major topics. Click one of these links to display subcategories 
and a list of topics. Click a subcategory to display additional topics. After 

browse by topic

TIP On the Help window 
toolbar, click  Change Font Size 

 to increase or reduce the 
size of the text in the Help 
window.
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the appropriate topic is found, click the topic to display help on that topic. 
The information can be printed for further reference by clicking the Print 
button on the toolbar.

 If there is a connection to the Internet, Help will browse topics at the 
 Microsoft Office Online Web site. The  Connection Status menu in the 
lower-right of the  Help window indicates the source of the help content. 
Click the Connection Status menu to display commands for changing the 
help source.

 Help also supports  keyword search for finding help topics. Below the 
toolbar is the search box where  search criteria is typed. Keywords should 
be separated by spaces, and Microsoft recommends using two to seven 
words for the best results. For example, to find information on adding 
page numbers to a document, type the criteria add page number and click 
Search. The window contents changes to:

 Click  in Search to specify the location of the search. Click the arrow 
to display a list of options which includes  Content from this computer, 
the option for using offline help.

 Practice: Using Help

!! DISPLAY THE WORD HELP WINDOW
a. Start Word.

b. In the upper-right of the Word window, click Help . The Word Help window is 
displayed. Note the Browse Word Help links.

Connection Status menu

keyword search

TIP The office.microsoft.com 
Web site offers tips and help 
with Office.



 
 
 
 

SAMPLE 

28 Chapter 1 Microsoft Offi ce Basics

c. In the lower-right corner of the window, click the Connection Status menu to dis-
play commands:

d. If the connection status is currently online, then click Show content only from this 
computer.

e. In the Browse Word Help topics, click What’s new. A list of topics is displayed.

f. Change the connection status to Show content from Office online.

g. In the Browse Word Help topics, click What’s new. The list of topics is longer.

@@ BROWSE FOR HELP
a. In the Browse Word Help topics, click Writing. Note the subcategories and topics 

displayed.

b. In the Subcategories, click Spelling, grammar, and thesaurus. A new set of topics 
is displayed.

c. Click Check spelling and grammar. Information about the spelling and grammar 
checkers is displayed.

d. Scroll through the information. At the bottom of the information, click Top of Page 
to return to the beginning.

## DO A KEYWORD SEARCH FOR HELP
a. In the search box, type .docx extension and then click Search. A list of topics is 

displayed.

b. Click Introduction to new file name extensions and Office XML formats. Infor-
mation about the new Office 2007 file format is displayed. Scroll through the 
information. What are three benefits of the new file format?

$$ USE THE NAVIGATION BUTTONS AND THEN CLOSE THE HELP WINDOW
a. On the toolbar, click Home . The home window is again displayed.

b. Click Back . The file extension information is again displayed.

c. Click Back  again. What is displayed?

d. Click Forward  until the home window is again displayed.

e. Click Close  in the upper-right corner of the window. The Word Help window 
is closed.

f. Exit Word.

 

 Chapter Summary
 Microsoft Office 2007 is a Windows application that includes Outlook, 
Word, Excel, Access, PowerPoint, and Publisher. Windows applications 
have an interface called a window. Outlook and Publisher windows have 
a menu bar and a toolbar. Word, Excel, Access, and PowerPoint windows 
include an Office Button , Quick Access Toolbar, and a Ribbon.
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 Input devices are used to communicate with a Windows application. 
A keyboard is used to enter text and numeric data. Other input devices 
include the mouse, stylus pen, and touchpad.

 The Office Button  and menu bar display commands for working with 
a document. The toolbar and Quick Access Toolbar contain buttons that 
represent different actions, such as saving a document. The Ribbon groups 
related commands into tabs. Contextual tabs are added to the Ribbon for 
certain activities. Some commands display a dialog box. A dialog box is 
a small window with options for completing an activity.

 The Office Button  or File menu are used to save, print, close, quit, and 
open. Folders are used to organize files, which are automatically given an 
extension when saved. A document is printed using the Print command. 
Closing a document means that it is removed from the application window 
and the file is no longer in the computer’s memory. Quitting an application 
removes an application from the desktop and the program is no longer in 
the computer’s memory. Opening a file transfers a copy of the file contents 
to the computer’s memory and then displays it in a window.

 A search engine is used to locate information on the Web. Search crite-
ria is used to specify which pages are to be located. Operators including 
+, –, space, AND, OR, and NOT can be used in specifying criteria. When 
operators are used, a Boolean expression is formed. There are guidelines 
for citing electronic material on the Internet. The primary purpose of a 
citation is to give credit to the original author and allow the reader to locate 
the cited information.

 Multitasking is an operating system feature that allows more than one 
application to run at a time. The taskbar displays buttons that represent 
each open file or application.

 E-mail is the sending and receiving of messages over a communications 
network such as a LAN or the Internet. To send and receive messages, an 
e-mail address and an e-mail client is required. The risks of using e-mail 
include receiving malicious code in an e-mail message. When communi-
cating through e-mail, professionalism and courtesy are expected. This 
includes following e-mail rules of etiquette and a code of ethics.

 Microsoft Outlook is an e-mail client. It includes an Address Book for 
storing contact names and e-mail addresses. The Insert tab is used to attach 
a file to an e-mail message. Related e-mail messages should be organized 
into folders. The Instant Search pane is used to find e-mail messages.

 Outlook has a Junk E-mail Filter, which catches obvious junk mail, or 
spam, and automatically places it in the Junk E-mail folder. It is also pos-
sible to block messages from specific senders.

 When using e-mail there are security risks that must be addressed to 
minimize the possibility of malicious code damaging important data. 
Many viruses and other forms of malicious code have been associated with 
e-mail attachments. Precautions to avoid getting a virus include using anti-
virus software, updating antivirus software frequently, always scanning 
attachments for viruses, and being cautious with personal information.

 The Microsoft Office Help window functions like a browser with but-
tons for going backwards and forwards through visited topics. Help 
browses the Microsoft Office Online Web site as well as content installed 
on the computer when Office was installed.
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 Vocabulary

Access   The Office database application.

Access key   A key that is indicated by the underlined 
character in a command.

Add-ins   Programs that extend the capabilities of 
an Office application.

Address book   Outlook tool that stores contact 
names and e-mail addresses.

Alt key   Used with an access key to display a 
menu.

Boolean expression   An expression that evaluates 
to either true or false.

Check box   An element in a dialog box that allows 
the user to select or clear an option.

Click   Pressing the left mouse button and releasing 
it quickly.

Closing a document   Removing a document from the 
application window and the file from the computer’s 
memory.

Command button   An element in a dialog box that 
initiates an action when clicked. More commonly 
called button.

Contextual tab   A tab added to the Ribbon for cer-
tain activities.

Default button   The button displayed with a thicker 
border when a dialog box is first displayed.

Dialog box   A small window with options for com-
pleting an action.

Double-click   Pressing the left mouse button twice 
in rapid succession.

Drop-down arrow   A text box feature that can be 
clicked to display a list of items to choose from.

E-mail   Electronic mail. The sending and receiving 
of electronic messages and computer files over a 
communications network such as a LAN or the 
Internet.

E-mail client   Software used to read, create, and send 
e-mail messages, list and organize e-mail messages, 
and manage addresses in an address book.

E-mail server   A computer running special software 
and connected to the Internet.

Excel   The Office spreadsheet application.

Extension   Indicates the file type and is used by 
the application to recognize files.

File   A collection of related data stored on a lasting 
medium, such as a hard disk.

File name   A unique name for a file.

Folder   Used to organize commonly related files.

Identity theft   A crime that seeks to obtain confi-
dential information in order to rob an unsuspecting 
individual of his or her identity.

IMAP server   An e-mail server used for incoming 
mail.

Input device   A device used to communicate with 
a Windows application.

Insertion point   A blinking vertical line in a docu-
ment that indicates where the next character typed 
will be placed.

Instant  Search pane   The Mail window pane that 
allows for searching e-mail documents.

Interface   The area on the screen where the user 
interacts with a software application.

Keyboard   Used to enter text and numeric data.

Keyboard shortcut   A sequence of keys that executes 
a command.

Mail window   The Outlook window containing 
e-mail tools.

Menu   A list of commands.

Menu bar   A row of menu names.

Message header   The portion of an e-mail message 
containing the subject, recipients, and sender of the 
message.

Microsoft Office 2007   A Windows application 
that consists of several applications, each designed 
to perform specific tasks.

Mouse   An input device that is used to select com-
mands and respond to application prompts.

Mouse pointer   An image on the screen, usually 
in the shape of an arrow, that indicates the position 
of the mouse.

Multitasking   An operating system feature that 
allows more than one application to run at a time.



 
 
 
 

SAMPLE 

Chapter 1 Microsoft Offi ce Basics 31

Native format   The format that an application nor-
mally uses for saving a file.

Navigation Pane   The Mail window pane that lists 
folders where e-mail messages are stored.

Opening a file   Transferring a copy of the file con-
tents to the computer’s memory, which displays it 
in a window.

Option button   An element in a dialog box that 
allows the user to choose from a set of options.

Outlook   The Office e-mail client.

Overwrite   The process of replacing an existing file 
with one that contains changes.

PDF   File format which preserves all document 
formatting.

Pharming   An e-mail security threat involving 
online fraud and identity theft.

Phishing   An e-mail security threat involving online 
fraud and identity theft.

Point   Sliding the mouse until the pointer is posi-
tioned on an object.

Pointing stick   A pointing device that is sometimes 
found on a notebook computer.

POP3 server   An e-mail server used for incoming 
mail.

PowerPoint   The Office presentation application.

Publisher    The Office desktop publishing 
application.

Quick Access Toolbar   A group of buttons for 
executing commands.

Quitting an application   Removing an application 
window from the desktop and the program from the 
computer’s memory.

Reading Pane   The Mail window pane that displays 
the contents of the selected message.

Ribbon   Related commands that are divided into 
tabs.

Right-click   Pressing and releasing the right mouse 
button quickly.

Search criteria   The words or phrases used in a 
search.

Search engine   Used to locate information on the 
Web.

Scroll   To bring unseen parts of a document into 
view.

Scroll bar   Dragged to bring unseen parts of the 
document into view.

SMPT server   An e-mail server used for outgoing 
mail.

Spam   Junk e-mail.

Status bar    Displays information about a 
document.

Stylus pen   A device on a handheld computer that 
performs the same functions as a mouse.

Taskbar   A Windows operating system feature that 
displays buttons for each open file or application.

Text box   An element in a dialog box that allows 
the user to enter information.

Thumbnail   A miniature version of a document.

Title bar   A horizontal bar that displays the name 
and type of document.

To-Do Bar   The Mail window pane that lists appoint-
ments and tasks.

Toolbar   A group of buttons for executing 
commands.

Touchpad   A pointing device that is sometimes 
found on a notebook computer.

Trackball   A pointing device that is sometimes 
found on a notebook computer.

Trojan horse   Malicious code that appears like a 
useful program.

Virus   Malicious code attached to a program that 
may come as an e-mail attachment.

Web-based e-mail client   E-mail client that runs 
in a browser.

Webmail account   A Web-based e-mail client. See 
Web-based e-mail client.

Wheel   A mouse component that can be rotated to 
scroll through a document.

Window   The interface of a Windows application.

Windows application   Programs or software 
written by professional programmers to perform 
specific tasks and run under the Windows operating 
system.

Window corner   Dragged to size the window. 
Located in the bottom-right corner of the window.

Word   The Office word processor application.

Worm   Malicious code that can replicate itself, use 
up a system’s memory, and bring down a system.
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 Office Commands

Add Sender to Blocked Senders List   Blocks messages 
from specific senders. Found in the menu displayed by 
right-clicking a message and selecting Junk E-mail.

Address Book    Displays the Address Book. Found 
on the Outlook toolbar.

Attach File   Displays the Insert File dialog box. Found 
on the Insert tab in a new message window.

Back    Displays a previous help topic. Found on 
the Help window toolbar.

Cc   Displays the Address Book where a contact can 
be selected.

Close    Removes a window or dialog box from 
the screen. Found in the upper-right corner of a 
window or dialog box.

Connection Status menu   Contains commands for 
changing the source of help content. Found in the 
lower-right corner of the Help window.

Delete    Moves an e-mail to the Deleted Items 
folder. Found on the Outlook toolbar.

Dialog Box Launcher    Displays a dialog box. 
Found in a tab group on the Ribbon.

Exit Word   Quits an application. Found in the  
menu.

Find add-ins for other file formats   Displays a Help 
window with directions for installing add-ins. Found 
in  j Save As.

Forward    Displays the next help topic. Found on 
the Help window toolbar.

Help    Displays information about the dialog box 
elements. Found in a dialog box.

Help    Displays the Microsoft Office Help win-
dow. Found in the upper-right corner of an Office 
application window.

Home    Displays the Help home window. Found 
on the Help window toolbar.

Mail Message   Displays a window for composing a 
mail message. New on the toolbar can be used instead 
of the command.

Mark as Not Junk   Moves a message from the Junk 
E-mail folder to the Inbox folder. Found in the menu 
displayed by right-clicking an e-mail message in the 
Junk E-mail folder.

Maximize    Expands a window to fill the screen. 
Found in the upper-right corner of a window.

Minimize    Hides a window. Found in the upper-
right corner of a window.

New Entry   Displays the New Entry dialog box. Found 
in the File menu in the Address Book dialog box.

New Folder   Creates a new folder in the Navigation 
Pane. Found in the menu displayed by right-clicking 
a folder in the Outlook Navigation pane.

Off   Turns off the Reading Pane. Found in the View 
j Reading Pane menu.

Office Button   Displays a menu of commands 
for opening, saving, and printing a document.

Open   Opens an existing document. Found in the 
 menu.

Options   Used to view and edit the Blocked Senders 
list. Found in the Tools menu.

Print   Prints a document. Found in the  menu.

Print    Prints an e-mail. Found on the Outlook 
toolbar.

Print    Prints a help topic. Found on the Help 
window toolbar.

Refresh    Reloads a help topic. Found on the Help 
window toolbar.

Reply   Used to create an e-mail message response 
to the selected message.

Restore Down    Restores a window to its previous 
size. Found in the upper-right corner of a window.

Save   Saves a document. Found in the  menu. Save 
 on the Quick Access Toolbar can be used instead 

of the command.

Save Attachments   Saves an attachment. Found in 
the File menu.

Send/Receive   Sends and receives e-mail messages.

Stop   Stops a help topic from loading. Found on 
the Help window toolbar.

   Displays the Address Book where a contact 
can be selected.
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 Review Questions

1. a) What is a Windows application?
 b) List three examples of Microsoft Office appli-

cations available on your computer.

2. a) What is a window?
 b) What does the Office Button display?
 c) What do the toolbar and Quick Access 

Toolbar contain?
 d) What are the Ribbon and menu bar used 

for?
 e) Which button is used to expand a window 

to fill the screen?

3. a) What are input devices used for?
 b) List two examples of input devices not men-

tioned in the text.

4. a) Which keys must be pressed to insert an 
uppercase “k” at the insertion point?

 b) Which key is used to move the insertion 
point to the beginning of a line of text?

 c) Which key is used to erase the character 
directly to the left of the insertion point?

 d) Which key is pressed to end a paragraph?

5. a) How is the mouse used to position the inser-
tion point?

 b) What is double-clicking?

6. What do the arrows next to commands in the 
 and File menus indicate?

7. a) How can the access key for a command be 
determined?

 b) Which key is used to remove a menu from 
the screen?

 
8. a) What is a keyboard shortcut?
 b) Explain how keyboard shortcuts can increase 

productivity.

9. a) What is the Ribbon?
 b) What is a contextual tab?
 c) How is the Ribbon minimized?

10. a) What is a dialog box used for?
 b) List three elements found in a dialog box.

11. a) What is a file?
 b) What are folders used for?
 c) Why is it important to give files and folders 

descriptive names?
 d) Explain how you could use folders to orga-

nize your files.
 e) What does the extension at the end of a file 

name indicate?

12. What happens when a document is closed?

13. What happens when an application is quit?

14. What happens when a file is opened?

15. What is used to locate information on the 
Web?

16. a) List three search engine Web sites.
 b) Which search engine do you prefer to use 

and why?
 c) What is search criteria?

17. a) What are logical operators used for?
 b) List three logical operators.
 c) What is the name of the expression that is 

formed by using logical operators?

18. a) Why is it necessary to cite sources?
 b) List a citation method not discussed in this 

chapter.
 c) On August 2, 2009 you accessed a posting 

on the Clewiston Kite Surfing discussion 
group at ht tp: / /www.Lpdataf i les.com /
kitesurf/color.txt. The posting was made by 
Tara Perez on the topic of kite colors on June 
3, 2009. Write a citation for a research paper 
that quotes Tara’s posting.

19. a) What is multitasking?
 b) List an example of a classroom assignment 

that would require multitasking.

20. a) What is e-mail?
 b) What is required in order to send and receive 

e-mail messages?
 c) List three examples of e-mail clients.

21. What does e-mail etiquette mean? Give an 
example.
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22. Why is it important to follow a code of ethics 
when using e-mail?

23. List the steps for composing and sending an 
e-mail message.

24. What is the Address Book used for?

25. a) List three formats that can be used for e-mail 
attachments.

 b) Why is the PDF format commonly used for 
e-mail attachments?

 c) What is an add-in?

26. a) Explain how you could organize your e-mail 
messages into folders.

 b) Explain how to find all of the e-mails that 
contain the word “homework.”

27. a) What is spam?
 b) How can messages from specific senders be 

blocked?

28. a) Describe cybercrimes associated with 
e-mail.

 b) List three forms of malicious code.
 c) How can identity theft be prevented?

29. List three ways to minimize the possibility of 
malicious code damaging data.

30. What are two ways to find information when 
using the Help window?

True/False

31. Determine if each of the following are true or 
false. If false, explain why.

 a) Access is a spreadsheet application.
 b) Publisher is an application used for desktop 

publishing.
 c) The title bar displays the file name and type 

of document.
 d) A window is hidden when Maximize  is 

clicked.
 e) Press the Home key to move the insertion 

point to the end of a line of text.
 f) Press the Alt key to cancel the current 

operation.
 g) A dimmed command can be selected.
 h) An arrow on a button indicates that 

additional commands are available.
 i) The Format tab is displayed on the Ribbon 

when Word is started.

 j) The default button in a dialog box is selected 
by pressing the Enter key.

 k) Answer to History ? is an example of a valid, 
descriptive file name.

 l) Any changes made to a document after sav-
ing are automatically stored in the file on 
disk.

 m) The file extension .docx indicates the file was 
created in Excel 2007.

 n) It is possible to print only the second page of 
a document.

 o) A Boolean expression evaluates to either true 
or false.

 p) MLA is an accepted form for citations.
 q) A word processor application and a spread-

sheet application can be running at the same 
time.

 r) Only one Word document can be opened at 
a time.

 s) Outlook is an e-mail client.
 t) E-mail messages are private.
 u) Phishing is a type of online fraud.
 v) A virus is a type of computer game.
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 Exercises

Exercise  1   ——————————————————— Computer Lab
Research your classroom computer lab and workstation by typing the answers to a series of questions.

a) In a new Word document, type Class Computer Lab and Workstation and press Enter 
twice.

b) Type Microsoft Office Applications and press Enter.

c) Type the names of the Microsoft Office applications available from your computer 
workstation, pressing Enter after each application name.

d) Type Input Devices and press Enter.

e) Data is entered into a Windows application using an  input device. Examples of input 
devices include the  keyboard,  mouse,  scanner,  CD/DVD drive, and  disk drive. Type 
the input devices connected to your computer workstation, pressing Enter after each 
device.

f) Type Storage Media and press Enter.

g) Files can be stored for later retrieval on various types of storage media, such as a  disk, 
CD/DVD , Zip disk, or memory key. Type the types of storage media you are able to 
save your files on, pressing Enter after each type of storage media.

h) Type Output Devices and press Enter.

i) Output devices display or store processed data.  Monitors and  printers are examples of 
display output devices. The CD/DVD burner and memory keys are examples of  output 
devices used for storing data. Type the output devices connected to your computer, 
pressing Enter after each device. 

j) Type Printer and press Enter.

k) Common classifications of printers include  laser and  dot matrix. A laser printer uses 
a laser and  toner to generate characters and graphics on paper. An ink jet printer uses 
an ink cartridge to place very small dots of ink onto paper to create characters and 
graphics. Classify the type of printer that is connected to your classroom computer 
lab.

l) Press Enter.

m) Type your first and last names and the date.

n) Save the document naming it Computer Lab and print a copy.
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Exercise  2  ——————————————————————————
Dialog boxes are used to communicate with an application. Become familiar with dialog box elements 
by completing the following steps: 

a) In new Word document, display the Open dialog box.

b) Identify the elements found in the Open dialog box.

c) Click Cancel to remove the dialog box without applying any options.

d) Display the Print dialog box.

e) The name of the default printer attached to the workstation or network is listed in the 
Printer Name box. What is the name of the default printer?

f) Some workstations and networks have more than one printer connected. If more than 
one printer is connected, they will be listed in the Printer Name list. Click the Name list 
and write the names of any other printers in the list.

g) What would be typed in the Pages box to print page 5, 6, and 7 of a document?

h) In the Print range section, is it possible to select more than one option button?

i) Click Cancel to remove the dialog box without applying any options.

Exercise  3  ————————————————————— Passwords
It is important to create strong passwords and keep your computer  password a secret. Learn tips on 
password security by completing the following steps.

a) In a new Word document, type the title Computer Passwords and press Enter. 

b) Type the following without pressing the Enter key: It is important to keep your password 
a secret so that other individuals cannot gain unauthorized access to your computer. 
Do not share your password with anyone and if you receive an e-mail requesting your 
password, even if it looks like it is from a legitimate source, do not provide the requested 
information.

c) Press Enter.

d) Type the following without pressing the Enter key: Strong passwords are more secure 
and are necessary for protecting your personal information. Passwords should appear 
to be a random string of characters. Words that are in a dictionary, a sequence of 
characters, or repeated characters are poor choices for passwords. A strong password 
will be lengthy with at least 8 to 14 characters. A combination of letters (both uppercase 
and lowercase), characters (numbers and letters), and symbols ($, %, #, and so on) 
make it more difficult for someone to try to retrieve your password. One technique for 
creating a strong password is to use a phrase, including the spaces, if possible.

e) In a new sentence, list two examples of what would be considered secure passwords 
and two examples of passwords that would be easy to guess.

f) Press Enter and then type your first and last names and the current date.

g) Save the document naming it Passwords.

h) Close the document.
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Exercise  4  ———————————————————E-COMMERCE
E-commerce Web sites are created by businesses for the purpose of selling their products or services 
to consumers online. Learn more about  e-commerce by completing the following exercise.

a) Open E-COMMERCE, which is a Word data file for this text. Read the document.

b) Press the Page Down key.

c) Press the Page Up key.

d) Position the insertion point at the start of the last paragraph, which starts “Wireless 
technology…”

e) Press the End key.

f) Press the Home key.

g) Position the insertion point after the period in the last sentence in the last paragraph.

h) Press Enter.

i) Type your first and last name.

j) Save the modified E-COMMERCE and print a copy.

k) Minimize the window.

l) Maximize the E-COMMERCE window.

m) Close the document.

n) Quit Word.

Exercise  5  ——————————————————————————
Examine and evaluate Web site content by completing the following steps.

a) In Internet Explorer, enter the URL: www.cnn.com

b) Read the content on the home page.

c) On what date was the Web page last updated?

d) Is the information incorrect or incomplete in order to give a particular or slanted view 
of a topic. Explain your answer.

e) Is the information truthful and trustworthy? Explain your answer.

f) In Internet Explorer, enter the URL: www.earthday.net

g) Repeat steps (b) through (e) for the Earth Day Network Web site.
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Exercise  6  ——————————————————————————
You are interested in finding a job in Los Angeles, California and are skilled in Web site design. A 
full-time position with a local Web site design company would be ideal.

a) Conduct a search on the Internet using at least two search engines to find two possible 
positions. On a separate sheet titled References, cite each source.

b) Write a brief description of each of the positions that you found.

c) Once you have found the position of your choice, you need information on making 
the move to Los Angeles. First, you will want to rent an apartment and cannot afford 
more than $1,500 a month. Conduct a search on the Internet to come up with brief 
descriptions of three apartments in Los Angeles that rent for $1,500 or less.

d) Add a paragraph that describes all three apartments, including number of bedrooms 
and bathrooms and rent per month.

Exercise  7  ——————————————————————————
Your English instructor has assigned a report on the  American  authors Kurt Vonnegut, Jr. and Ernest 
Hemingway. Keep in mind that knowledge of information like the titles of their books might help 
in your search. Because people maintain Web sites as homages to their favorite authors, but are not 
obligated to check their facts for accuracy, it is a good idea to double check the information you find 
with more than one Web site.

a) Conduct a search on the Internet using at least two search engines to find biographical 
data on each author.

b) Write a paragraph of biographical information for each author.

c) On a separate sheet titled References, cite each source.

Exercise  8  ——————————————————————————  
You have decided to purchase an automobile that costs $20,000 or less. A used car will probably give 
you the best value.

a) Conduct a search on the Internet using at least two search engines to find four used 
cars in your price range. On a separate sheet titled References, cite each source.

b) List each car’s specifications and price.

c) Select one of the four cars for purchase and explain your choice in a paragraph.

d) You will need automobile insurance for your used car. Search the Internet and find 
two insurance companies that offer automobile insurance.

e) List the contact information for the two insurance companies.
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Exercise  9  ——————————————————————————
A good friend has been diagnosed with Carpal Tunnel Syndrome and would like you to find out as 
much as you can about her injury.

a) Conduct a search on the Internet using at least two search engines to find three Web 
pages that have information about  Carpal Tunnel Syndrome.

b) Write a one-paragraph description of the injury.

c) In a second paragraph, write about possible treatments for the injury.

d)  Ergonomics is the science that studies safe work environments. Many health-related 
issues, such as carpal tunnel syndrome are related to prolonged computer use. Research 
ergonomics and write a few paragraphs that outline preventative measures that can 
be taken to avoid health-related issues, such as carpal tunnel syndrome. 

e) On a separate sheet titled References, cite each source.

Exercise 10  ——————————————————————————
You and a friend have decided to take a trip to Australia. Before you go you should find out about 
airfare, hotels, climate, travel documents, and restaurants. Information about Australia’s museums and 
tourist attractions would also be helpful in planning the trip.

a) Conduct a search on the Internet using at least two search engines to find six Web sites 
that have information about Australia.

b) Write a one-paragraph description of the country.

c) In a second paragraph, write about the places that you might visit.

d) On a separate sheet titled References, cite each source.

Exercise 11  ——————————————————————————
You have decided to investigate possible career paths.

a) Conduct a search on the Internet using at least two search engines to find six degree 
programs in a field you are interested in.

b) List each program location (college name), the degree, the number of credits required 
to finish the degree, and some of the costs involved.

Exercise 12  ——————————————————————————
In this exercise you will research and compare the advantages and cost of obtaining Internet access 
through three different telecommunication options.

a) Use the Internet and newspapers to research Internet service providers (ISPs).

b) Compare the costs and the advantages of three different telecommunication options.

c) Write a one paragraph conclusion that explains what telecommunication option would 
be the best choice.

d) Write a citation for each source.
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Exercise 13  ——————————————————————————
In this exercise you will further research emerging technologies and find real-life examples of how 
these technologies have impacted individuals and businesses.

a) Use the Internet to learn more about at least three emerging technologies. Look spe-
cifically for information on how these emerging technologies impact individuals and 
businesses. For example, speech recognition technology greatly impacts those indi-
viduals who must rely on voice input rather than keyboard input.

b) Write a two-page report that summarizes the impact of and lists several functions of 
the emerging technologies you have researched.

c) Write a citation for each source.

Exercise 14  ——————————————————————————
Update your Address Book and organize your Inbox by completing the following steps.

a) Collect e-mail addresses from six people you would be likely to send e-mail messages 
to and are not in your  Address Book.

b) Create six new entries in the Address Book.

c) Send an e-mail to a classmate who is working on the same exercise. Type the subject 
Address Book Completed and type the following message, replacing Name with your 
name: 

I am finished typing the information for my Address Book. Have you finished? 
Please reply using the Reply button.

Name

d) Reply to the classmate’s e-mail message using Reply. You may first need to click Send/
Receive to receive the message from your classmate.

e) Organize your e-mail messages by creating two new folders, naming the folders appro-
priately, and then moving messages to the new folders. 

Exercise 15  ——————————————————————————
Many  computer viruses have been associated with e-mail attachments.

a) Conduct a search on the Internet to find information about a virus associated with an 
e-mail attachments.

b) Write a one-paragraph description of the virus. Include details, such as the damage 
caused by the virus and steps necessary to remove the virus.

c) On a separate sheet titled References, cite each source.
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Exercise 16  ——————————————————————————
A good way to learn about career options is to interview a professional in a particular career.

a) Choose an individual to interview. The career you will be learning about does not 
necessarily have to be one you care to follow. The purpose of the interview is to learn 
about the responsibilities and training required for a particular career. Consider a 
family friend, an instructor at your school, or the parent of a friend.

b) Obtain the e-mail address of the individual you would like to interview. Use appropriate 
etiquette in obtaining the e-mail address, including asking permission to e-mail the 
individual.

c) Brainstorm to come up with a list of questions to use during the interview. Questions 
could include:

 “What is your job title and what are your key responsibilities?”

 “What is your favorite part of the job?”

 “What kind of training does your job require?”

 Limit the list of questions to between four and six.

d) E-mail the individual you have selected and copy your instructor in on the e-mail by 
placing your instructor’s e-mail address in the Cc box. Use appropriate etiquette when 
composing the e-mail. Your e-mail should include:

 • the reason for the e-mail

 • a possible date, time, and location for the interview

 • the list of questions you intend to ask

 • the estimated length of the interview

 • a prompt for a reply to confirm the date and time.

e) Check your e-mail on a regular basis so that you will be able to promptly respond to 
the reply sent by the person you plan to interview. In your reply, thank the individual 
for agreeing to an interview and then restate the agreed to date, time, and location. 
There may be a few e-mails between you and the individual you plan to interview 
until you find a date, time, and location that works for both of you. In each e-mail, use 
appropriate etiquette. Be sure to cc your instructor in each e-mail.

f) Arrive for the interview at least 10 minutes early. Be sure to have pencil and paper 
with you. A voice recorder may be helpful, but ask the person you are interviewing 
for permission to use it. Appropriately greet the person you are about to interview. As 
you ask your questions, restate the response to reduce the possibility of misinterpret-
ing information. Pay careful attention to the time so that you do not go past the time 
stated in the e-mail.

g) Follow up your interview with an e-mail thanking the individual for their information 
and time. Again, copy your instructor in on the e-mail.

h) In an e-mail to your instructor, summarize the findings from your interview.
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Exercise 17  ———————————————— Reflection Chapter 1
Reflect on what you have learned in this chapter by completing the following exercise.

a) In a new Word document, type three entries from the vocabulary list that you were 
previously unfamiliar with. Press Enter after each word.

b) Below the three vocabulary words, press Enter, and in a sentence, describe elements 
of the interface that you were previously unfamiliar with and then press Enter.

c) What productivity tips did you learn in this chapter? Press Enter after typing your 
answer.

d) Many users follow a consistent practice when naming files. For example, all docu-
ments for a club could begin with the club name, as in Computer Club May Newsletter. 
Explain one way you could be consistent in naming files and give an example. Press 
Enter after typing your explanation.

e) The  File list in the Open dialog box can display folder contents in different ways. Display 
the Open dialog box and then click  in  to display a menu of options:

 

 Click Details to display information such as the file size, file type, and date modified 
for the files and folders in the File list. Select the other view options and note how the 
File list is displayed. Which file organization in the Open dialog box do you prefer? 
Why? Press Enter after typing your answer.

f) What did you learn about search engines that could make you more efficient when 
searching the Web? Press Enter after typing your answer.

g) What did you learn about e-mail ethics? Press Enter after typing your answer.

h) What organization tips did you learn in this chapter? Press Enter after typing your 
answer.

i) Explain how you will be able to use Office Help as you work through this course. Press 
Enter after typing your answer.

j) Describe what you hope to learn in this course. Press Enter after typing your 
answer.

k) Type your first and last name.

l) Save the document naming it Reflection Chapter 1 and print a copy.




